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If you are unfamiliar with the
terminology, refer to the back of
this guide for basic explanations.
If you are still unsure about the
instructions, we recommend
letting our designers set-up your
files for you.

Disc Printing Options

1. PAPER LABELS: Quantity: 10 - 5000+

Paper labels are available in a Full Face label which offer maximum
printable area. Paper labels are economical and, if artwork meets
our specifications can be output quickly, usually within a day once
we have customer sign off and replication rights forms have been
submitted. Labels are run on our inhouse digital colour printer and
colour is vibrant and rich. We run our labels 6-up so if needed we
can output large quantities very quickly. Colour varys slightly with
digital technology.

2. COLOUR THERMAL PRINTING: Quantity: 10 - 2000+

Colour Thermal printing is our premium output solution when quality
and turnaround time is crutial. Photographs and graphic images look
exceptional on this method of printing. Thermal printing uses a heat
process and colour ribbons to directly transfer images to the disc.
This creates a very stable product that will not smear and is water
resistant. Colour varys with thermal technology. It is most noticable
with solid and gradient colours.

3. SILKSCREEN AND OFFSET PRINTING: Quantity: 500+

Silkscreen and Offset printing offers our clients the greatest value.
This is your best choice for projects that require colour accuracy and
high volumes. Price per disc continues to decrease as volumes go
up, much like conventional printing. Unless you are an expert with
trapping, overprinting, bleeds and boosting colours, it is best to have
our designers prep your files. Typical turnaround times average two
weeks from date we have received masters, replication rights forms
have been submitted and artwork proofs have been signed off.

4. BLACK THERMAL: Quantity: 10 - 2000+
Black Thermal printing is an economical method for printing on discs.
This method is effective for black reverse artwork and grayscale
images. Screens and small type print well.
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Paper Labels
Quantity: 10 - 5000+

Live area for paper labels is 18mm inner and 118 mm outer.

Paper labels are run on label sheets that are already die cut. Once you
are ready to submit artwork it is important to remove all dielines or
to turn off this layer. To help us position your label, leave the small
crosshair in the middle of your artwork.

Sample A
Example of an INCORRECT artwork file.

Issues with this artwork

1.) Dielines left on artwork.

2.) Type too close to edge of label.
3.) No bleeds.

4.) Center knocked out.

5.) No crosshair for positioning.

Sample B
Example of a CORRECT artwork file.

Corrections made to artwork

1.) Dielines left on artwork (temporary).

2.) Type moved away from the edges of label.
3.) Bleeds have been added for background.
4.) Crosshair added to aid in positioning.

Sample C

Example of CORRECTED artwork file ready
to be saved as a PDF for submission.

1.) Dielines removed.
2.) Crosshair left to aid in positioning.
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Sample A

Note: On CDs only, the substrate
is not uniform and at 39mm is
noticable through the white flood.
Shown as the white frosted area.
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Colour Thermal Printing
Quantity: 10 - 2000+

Colour Thermal Printing is our premium disc printing solution. Discs
are usually printed on specially prepared, discs with a white wash
already applied. We can thermal print on silver discs as well to
achieve special effects, as the colours are translucent. The finish is a
high gloss, stable finish which is waterproof and smudge resistant.

Live area for colour thermal printing is 22mm inner and 119mm outer.
This method of printing uses a cyan, magenta and yellow ribbon to
create blacks. Be aware that large areas of black tend to come out
with a dark redish brown hue.

Printing large areas of solid colour or gradients, as with any printing,
is a challenge as banding and/or fadeout may occur. Note: red, (100M
& 100Y) make up is the only solid colour that prints consistantly
where heavy coverage is required. Colour can vary slightly with
colour thermal printing.

If your artwork is a grayscale image we can switch our machines over
to run a black ribbon which gives outstanding grayscale results and
solid black floods.

Sample A
Example of a CORRECT artwork file.

1.) Dielines left on artwork (temporary).

2.) Type moved away from the edges of label.

3.) Bleeds added for background and yellow vector art.
4.) Crosshair added to aid in positioning.

Sample B

Example of CORRECT artwork file ready
to be saved as a PDF for submission.

1.) Dielines removed.
2.) Crosshair left to aid in positioning.
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Warning: If you are not

familiar with professional layout
software it is recommended

you use a professional graphic
designer. We have professional
graphic designers on site to
assist you with your project.

Artwork should be supplied as
an Adobe® lllustrator® file. All
fonts should be converted to
paths and all images should be
embedded.

We also accept hi-res PDF files
and Adobe® Photoshop® files. If
supplying Adobe® Photoshop®
files ensure all fonts are
rasterized or supplied.

live area/116mm outer live area

Template 22mm inner
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Silkscreen and Offset Printing
Quantity: 500+

For most DVD jobs our 22mm by 116mm template works well but
dimensions could vary slightly depending on which equipment we
use. For CD jobs, center live areas can vary from 22mm to 27mm.

Silkscreen and Offset artwork is the most complex artwork to set
up as it is similar to conventional printing. Maximum ink saturation
should be between 320 and 340. Additional consideration of the type
of discs being used is important as some discs have stacking rings.
You should be aware of the mirror bands near the center of the disc
as ink laydown over these areas can be detected.

There are various templates for Silkscreen and Offset printing. There
are multiple templates depending on the equipment we choose to
process your job with, whether your project is a CD, DVD or Blu-ray
and whether it is offset or silkscreened.

Once artwork is supplied we schedule your project with equipment
that can give the quickest return times and best quality for your
specific artwork.

When using our lllustrator® templates it is important that you do not
alter any of the layers and ONLY work on the artwork layer.

When running spot colours, there is a maximum of 1 colour you may
use EXCLUDING the whitewash layer.

o
o
o
o
[ |:| Live area 116mm/22mm ()
o
o
L]

\AmOrk Layer
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Unacceptable Artwork
(No Bleed, Center Hole
knocked out)

TEC
PRO scries

Acceptable Artwork
(Die lines in temporarily)

TEC
PRO scries

el
D —

Acceptable Artwork
(Ready to be forwarded)

Black Thermal
Quantity: 10 - 500+

If your project has screens and/or a lot of detail please consider our
high quality thermal printing option. Our high-end colour machines
offers a larger live area and outstanding output on grayscale images
and large solid floods when configured for black printing only.

Live area: 22mm - 119mm. When setting up files follow the same
specs for colour thermal printing. Please include a small crosshair in
the middle of your artwork to assist with positioning.
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Paper Printing Templates
General Overview

On all of our printing templates you will find:

1.) Red Dielines - Indicate live area where the paper will be cut or
folded.

2.) Greendashed lines-Indicate bleed, and show how far background
artwork should extend past the live area.

3.) Bluedashed lines - Indicate safe area. Important type and graphics
should not extend past these margins.

4.) Black lines - These lines are crop marks and are the only marks
left on artwork when submitting for printng.

When you submit your artwork, dieline, bleed lines and safe zone lines should be removed, leaving only the black cropmarks for positioning.
Art is cut at cropmarks as shown by red dieline. Art should extend to the 1p green line for bleed.Text and logos should be kept within the 0p9 blue safe zone.

cardboard_record_jacket.pdf rev.110608
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Page Options
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Using Templates in Photoshop®

Western does not recommend using Photoshop to create your final
art. The following guide is for beginners and will walk you through the
simplest way to prepare your art for final submission with Photoshop.
If you are an intermediate user, you should refer to our guides for
using InDesign or lllustrator.

1) Western’s PDF templates can be opened in Photoshop with the
“Open” command from the “File” menu. When you open the PDF
template, the “Import PDF” options will appear. Make sure that “Crop

"

to:” reads “Media Box” and “Resolution” reads 300. If these values
are not correct, you must change them. If you change the “Resolution”
value , you'll notice that the width and height values will change at

the same time. Press “OK.”

2) Thetemplateis now “Layer 1” inanew document, and the checkered
background is an indication of transparency. Rename the “Layer 1” to
“Template”. Fully lock the layer by selecting the layer and clicking the
padlock symbol to make sure that you don't accidentally draw on it or
move it. A padlock symbol should appear on the layer in the layer list
to indicate that it is locked.

3) Create the new layer underneath the template layer and name it
“Page”. Fill this layer with white to make the document easier to look
at while you're designing your art.

4) You can now create your art on any layers underneath the

“Template” layer. The “Template” layer should always be the top
layer, so that you can use it as a guide when you have finished.

continued...




Guide for
bt dabls M WESTERN

IMPERIAL MAGNETICS LTD <

Using Templates in Photoshop®
EeTUa -E

| Normal + | Opacity:

locks B o7 < (@] Fill [ 100% | - 5) To prepare your art for final submission, first turn off the “Template”

® Dnmﬁm a layer by clicking the eye symbol for the layer in the layer list. Your art

® | T ehotoshop Text should be completely visible without any parts knocked out.

- E Photo Background
2 D e

6) Next, use the “Flatten Image” command from the “Layer” menu.

When Photoshop® asks if you would like to “Discard hidden layers,
ek B o« ¢ @ i oo Lo press “OK”. Use the “Save As...” command from the “File” menu to

[ e - save your art as a TIFF file for submission.

® | T Photoshop Text

Photo Background
L

+ | Opacity: [ 100%] - |

Remember, you can save time by sending us your files through our

Hightail account:

https://www.hightail.com/dropbox?dropbox=wimmedia
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Using Templates in lllustrator®

1) Western’s PDF templates can be opened in lllustrator® directly with
the “Open” command from the “File” menu. When you open the PDF
template, you'll see a number of layers. All layers are locked in place
except for the “Artwork” layer. The “Artwork” layer is the only layer
that the designer should use for building the file.

2) Whenever you use the “Place” command to place artwork into the
file, ensure that the “Link” checkbox is NOT checked during the place
process. This will embed all artwork directly into the file, and will
avoid Link problems.

3) Once your art is finished, your live text (text that you've typed in
and is editable) needs to be converted to outlines. Select any live text
using the selection tool. This is what live text looks like when it

is selected.

4) Now convert your text to outlines by choosing the “Create Outlines”
command from the “Type” menu. This is what text looks like when
when it has been converted to outlines when it is selected. Outlining
your text converts it to a non-editable, vector format that Western can
use without needing to have the same fonts as you have.

continued...




Guide for

preparing
artwork

XN WESTERN

IMPERIAL MAGNETICS LTD <«

n Sample tif

G 40

Layers

Instructions

G|i|>

LT

Bleed

G|i|>

a I 3 Safe Zone

8 | » [ ] Dpieline

® | & I » | | Crosshair

a |-| » [ | white Knockout Layer

® |» inmrk

Using Templates in lllustrator®

5) Let’s do one last check to confirm that all placed artwork is
embedded and not linked. The “Links” palette shows all placed files,
whether they are embedded or linked. If they are embedded, they
will have the square and triangle symbol displayed. If any files do not
show this symbol , select the file from the list and choose “Embed
Image” from the “Links” palette drop-down menu.

6) Now turn off the “Instructions, “Bleed”, “Safe Zone” and “Dieline”
layers, leaving only your art and the “Crosshair” or “Cropmarks”
layer visible for us to position your art. Save your art as a PDF file.
When the “Save Abode PDF” options window appears, choose
“[Press Quality]” as the “Adobe PDF Preset” and then save the file.

Remember, you can save time by sending us your files through our
Hightail account:

https://www.hightail.com/dropbox?dropbox=wimmedia
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How to Submit Files

1. E-MAIL - up to 8 megabytes
Artwork can be sent directly to your sales representative.

2. OUR HIGHTAIL ACCOUNT - files over 8 megabytes
https://www.hightail.com/dropbox?dropbox=wimmedia

You can send files (up to 2 GBs) directly to Western through this page.

Please be sure to include your sales representative and job number
for tracking purposes.

Put all the files you want to upload into one folder and then ZIP the
whole folder. The file you submit should be a ZIP file, not a ZIPX, RAR
or other compressed file format.

DO NOT SEND multiple Hightail files.

Failure to follow above procedures may result in delays to your
project.

3. WHAT TYPE OF FILES DO WE ACCEPT?

Western supports Adobe® CC. For best results we prefer Hi-Res
layered PDFs. We support Indesign, lllustrator and Photoshop. We
can also work with Tiffs, JPEGs and EPS files if they are saved out
correctly.

4. WHY PDFS?

PDF files, when saved out properly contain all the information needed
in order to output your project. Submitting other files, like Indesign,
Illustrator or Photoshop is fine, but the files are much larger and it
takes us more time to prep your artwork and check your files. All
linked graphics and fonts also must be included in your submission
file to avoid delays. Western then needs to go through the file, load
fonts and re-link all images. This may add cost and time delays to
your project.
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Glossary

BLEED - Area of image that extends past live area of the artwork.

CMYK - The letters stand for Cyan, Magenta, Yellow and Black. These
colours are used for process printing or four colour printing.

CROP MARKS - Marks shown outside of the live area of a printed
project indicating where the job will be trimmed once printed.

INK SATURATION - Refers to the total percentage of ink laydown.
Generally only used with process colour. Maximum saturation should
be no more than 320 to 340 percent.

LIVE AREA - The area of the sheet or disc that mark the physical edges
of the artwork. Usually indicated with either crop marks or die lines.

PANTONE® COLOUR - Refers to a colour system that utilizes solid
colour options. Designers will have a Pantone® book that has number
codes for all the colour swatch samples.

PDF - Stands for Portable Document Format and is the industry
standard for supplying files for output. When supplying PDFs insure
fonts are embedded, resolution is set to 300ppi, bleed is included and
die lines are turned off.

PROCESS COLOUR - Refer to CMYK colour.

REGISTRATION MARKS - Marks shown outside of the live area on
a printed piece indicating registration of multiple plates for colours
and/or varnishes.

RGB - The letters stand for Red, Green and Blue. These colours are
used for creating colour on your computer monitor. The RGB colour
gamut cannot be fully reproduced onto print because this system is
a measure of light. 0 percentages of RGB gives you black and 100%
percentages give you white.

TRAPPING - A techique used to allow for a small overlap where two
different colours meet. Generally darker colours are choked and
lighter colours are spread.

SAFE AREA - This is the area that all important information should
stay within. Generally 3/16” (4.76mm) is the minimum distance any
type should be from the live area.

SILKSCREEN PRINTING (Discs) - This printing method is best for spot
colours. Screens tend to be fairly coarse so avoid choosing screen
percentages of chosen colours.

OFFSET PRINTING (Discs) - This printing method utilizes CMYK inks.
It is best used for photographs and images with texture in them.

Screens are finer then silkscreen printing.




